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What Is in This Guide?
This document describes the interface to MFG/PRO in character mode 
and for Windows. It also discusses navigation in programs built using the 
Object-Based Component Model (OBCM).

This guide teaches you how to move around in the interfaces and how to 
use the programs. It does not explain MFG/PRO functionality.

In MFG/PRO Version 9.0, MFG/PRO programs can also be accessed 
using the Network User Interface (NetUI) for the Java platform. The user 
interface for Web-enabled MFG/PRO is described in the Network User 
Interface Guide.

Other 9.0 Documentation
• For an overview of new features and software updates, see the 9.0 

Release Bulletin. 

• For software installation instructions, refer to the 9.0 Installation 
Guides.

• For instructions on accessing MFG/PRO programs with a Web 
browser over the Internet or an intranet, refer to the Network User 
Interface Guide.

• For information on using MFG/PRO, refer to the 9.0 User Guides.

• For technical details, refer to the 9.0 File Relationships and 9.0 
Database Definitions. 

• To review MFG/PRO program screens, refer to the Screen Book, 
Volumes 1–3. 

• To view documents online in PDF format, see the 9.0 Documents on 
CD. 

Online Help

MFG/PRO has an extensive online help system. Help is available for 
most fields found on a screen. Procedure help is available for most 
programs that update the database. Most inquiries, reports, and browses 
do not have procedure help.
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QAD Web Site

For MFG/PRO users with a QAD Web account, MFG/PRO 
documentation is available for viewing or downloading at:

http://support.qad.com/documentation/

To obtain a QAD Web account, go to:

http://support.qad.com/

The QAD Web site also has information about training classes and other 
services that can help you learn about MFG/PRO.

Conventions

MFG/PRO is available in several interfaces: Windows, character, Web 
browser, and an interface for object-oriented programs. To standardize 
presentation, the documentation uses the following conventions:

• MFG/PRO screen captures reflect the Windows interface.

• References to keyboard commands are generic. For example, choose 
Go refers to F2 in the Windows interface and to F1 in the character 
interface. The following tables identify the keyboard commands for 
the Windows and character interfaces. 

Windows Keyboard Commands

Navigation 
Commands

Keyboard 
Entry Description

Go F2 Moves to next frame.

End Esc Exits a frame, program, or menu.

Previous F9 or up arrow Retrieves previous record in a key data 
field.

Next F10 or down 
arrow

Retrieves next record in a key data field.

Enter Enter Moves to next field within a frame.

Tab Tab Moves to next field within a frame.

Back Tab Shift+Tab Moves back one field within a frame.

Exit Alt+X Closes a program.
 

http://support.qad.com/documentation
http://support.qad.com/
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Run Ctrl+R Starts a program by name.

Save (object) F12 In a key frame, moves to data entry; in 
data entry, saves and returns to key 
frame.

Print (object) Ctrl+P Prints browse or maintenance 
information.

Help 
Commands

Keyboard 
Entry Description

Field Help F1 Opens help on current field.

Procedure Help Shift+F1 Opens help on current program.

Browse Alt+F1 Displays choice of records.

Look-Up Browse Alt+F2 Displays choice of records.

About Ctrl+F1 Displays the program name.

Browse Options F7 Opens the browse options window. 

Browse Options Toggle Alt+F Turns the browse options on and off.

Browse Graph Shift+F11 Opens the browse graphing window.

Field Name Ctrl+F Displays the field name.

Edit 
Commands

Keyboard 
Entry Description

Delete Record F5 Deletes an open record.

Cut Ctrl+X Cuts a field or selection to clipboard.

Copy Ctrl+C Copies a field or selection to clipboard.

Paste Ctrl+V Pastes data from the clipboard.

Navigation 
Commands

Keyboard 
Entry Description
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Character Keyboard Commands

Navigation 
Commands

Keyboard 
Entry

Control Key 
Entry Description

Go F1 Ctrl+X Moves to next frame.

End F4 Ctrl+E Exits a frame, program, or menu.

User Menu F6 Ctrl+P Displays list of user-selected 
programs.

Previous F9 or up arrow Ctrl+K Retrieves previous record in a key 
data field and scrolls up in look-up 
browses.

Next F10 or down 
arrow

Ctrl+J Retrieves next record in a key data 
field and scrolls down in look-up 
browses.

Enter Enter  Moves to next field within a frame.

Tab Tab  Moves to next field within a frame.

Back Tab Shift+Tab Ctrl+U Moves back one field within a frame.

Menu Bar 
(object)

Esc, M  Accesses the menu bar.

Save (object) F12 In a key frame, moves to data entry; in 
data entry, saves and returns to key 
frame.

Print (object) Ctrl+P Prints browse or maintenance 
information

Help 
Commands

Keyboard 
Entry

Control Key 
Entry Description

Field Help F2 Ctrl+W Opens help on current field.

Procedure Help F2 Ctrl+W Opens help on current program.

Look-Up 
Browse

F2 Ctrl+W Displays choice of records.

Browse 
Options

F7 Opens the browse options window. 

Browse 
Options Toggle

Alt+F Turns the browse options on and off.

Field Name Ctrl+F Ctrl+F Displays the field name.
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Edit 
Commands

Keyboard 
Entry

Control Key 
Entry Description

Insert F3 Ctrl+T Enables text insertion.

Delete Record F5 Ctrl+D Deletes an open record.

Recall 
(standard)

F7 Ctrl+R Recalls last saved value in a field.

Cut F8 Clears a field.

Copy F11 Ctrl+B Copies a field.

Paste F11 Ctrl+B Inserts value that you copied.

Multiple Copy 
(standard)

F12 Ctrl+A Copies values from one or more fields 
and pastes them into the same fields of 
another record.

Clear Date Shift+? Clears the value in date fields.
 



CHAPTER 1

Windows Conventions

MFG/PRO for Windows is a Graphical User Interface (GUI). You can 
interact with it by using pictures or icons instead of typing commands at 
a keyboard. This chapter introduces you to some basic Windows 
conventions.

This chapter covers the following topics:

Introduction     8

Using the Mouse     8

Keyboard Actions     10



8 MFG/PRO USER INTERFACE GUIDE
Introduction
In this chapter you will become familiar with using the mouse to navigate 
through MFG/PRO for Windows. You can use the keyboard as well as the 
mouse to navigate.

Using the Mouse
The mouse is a pointing device for showing the computer what you want 
to do. You roll the mouse on a mouse pad to move a pointer on the screen. 
When the pointer is on an icon or a task you want to do, you click the 
mouse button.

Fig. 1.1
Mouse and 
Mouse Pointer

Mouse Pointer

The mouse pointer changes depending on the software you are using and 
the task you are performing, but on most systems it has three basic shapes.

Fig. 1.2
Mouse Pointers and 
Cursors

Mouse Pointer
Mouse Button
The actions in this book all 
use the left button.

Mouse

This insertion point is used for text and shows where your next

This pointer is used for graphics and for pointing at Windows
objects on the screen.

This hourglass shows that the computer is processing. While the
hourglass is visible, you wait.

keystroke will go.
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Clicking, Double-Clicking, and Dragging

Clicking once on the mouse button sends a different message than two 
brief clicks in quick succession (double-clicking).

Clicking

The menu bar at the top of most Windows screens contains the names of 
several task menus. To open a menu and read its contents, you click once 
on the name.

Fig. 1.3
Clicking

Double-Clicking

Double-clicking normally causes an action to occur, such as starting or 
ending a program. For example, double-clicking the MFG/PRO desktop 
icon starts MFG/PRO.

Clicking and Dragging

Dragging is accomplished by clicking on what you want to select and 
holding down the mouse button and moving the mouse. You might do this 
for any of the following reasons.

• You can reposition screens on your terminal. For example, you can 
move a message pop-up to better see the screen below it.

Ï See “Config” on 
page 20.

• QAD has enhanced some maintenance programs by rewriting them to 
run under the Object-Based Component Model (OBCM). Figure 1.5 
on page 10 shows an example of such a program. In OBCM 
programs, you can reconfigure a folder by dragging its tab to a new 
position.

Cut
Copy
Paste

Edit Image

Ctrl+X
Ctrl+C
Ctrl+V

User Menu Edit Queue Options Help

Click once here to 
reveal the Edit menu.

Edit Menu
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• You click and drag to select items such as text. Selecting means to 
highlight items for a desired operation. For example, to delete or copy 
a block of text, you must indicate which text. 

Keyboard Actions
You can use the keyboard equivalents to accomplish many of the same 
actions as the mouse. In many cases, this is faster and more convenient.

Fig. 1.4
Keystroke 
Equivalents

In OBCM programs, hold down the Alt key and press the underlined 
number to open an application.

Fig. 1.5
OBCM Program 
Keyboard 
Equivalents

Cut
Copy
Paste

Edit Image

Ctrl+X
Ctrl+C
Ctrl+V

User Menu Edit Queue Options Help

1.
Hold down the Alt key 
and press the 
underlined letter to 
open a menu.

2.
With the menu open, 
press the underlined 
letter to execute the task.

3.
Press these combinations 
at any time to execute the 
task, even with the menu 
closed.

Hold Alt,
press 
underlined
number.
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Starting MFG/PRO for Windows
Start MFG/PRO by choosing the option from the Windows Start menu, or 
by double clicking on its icon on the desktop or in a program group. 

The sign-on screen is the first screen you see when you run MFG/PRO. 
From it, you can:

• Enter your user ID

• Enter your password

• Get help about signing on

• Sign on to MFG/PRO

• Exit MFG/PRO 

Fig. 2.1
MFG/PRO Sign-On 
Screen

Enter your
User ID here.

Enter your 
password here.

Click here 
for help.

Click here to 
enter MFG/PRO.

Click here to 
exit MFG/PRO.
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Screen Elements
The MFG/PRO for Windows screen is divided into discrete sections. 
Figure 2.2 shows the standard MFG/PRO program interface.

Fig. 2.2
Standard
MFG/PRO for 
Windows Screen

QAD has enhanced some of the maintenance programs by rewriting them 
to run under the Object-Based Component Model (OBCM). These 
programs have a different interface than the standard Windows programs.

Using the Navigator Maintenance screen as an example, Figure 2.3 shows 
the screen elements in an MFG/PRO OBCM program.

Title Bar
Menu Bar
Tool Bar

Program
Window

Message Bar

PROGRESS
Status Bar
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Fig. 2.3
OBCM Program for 
Windows Screen

The following pages explain each screen element:

• Title Bar

• Menu Bar

• Tool Bar

• Program Window

• Message Bar

• PROGRESS Status Bar

Title Bar

The title bar describes the program you are running. You can also exit the 
program and minimize or maximize the screen from the title bar. 

Fig. 2.4
MS-Windows 95, 
98, and NT Title 
Bar

Title Bar
Menu Bar
Tool Bar

Program
Window

PROGRESS
Status Bar

Program Title

From the left, click the first 
button to minimize, the 
second button to maximize, 
and the third button to close 
the program.
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Menu Bar
You can perform various tasks by clicking the items on the menu bar. The 
drop-down menus associated with each one are described in detail in this 
section. Click on the drop-down menu, and choose an option by clicking 
it or pressing the underlined letter. Where possible, selections have 
accelerator key method access.

Fig. 2.5
Menu Bars 
in Windows

User Menu

The User Menu provides access to:

• User Menu Items

• User Tool Bar Items

• Run Program

• Exit

• PROGRESS Editor

The User Menu Items and User Tool Bar Items are user defined. You can 
use them to jump to other programs.

Standard Program 

OBCM Program 
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Fig. 2.6
User Menu

Running a Program from the User Menu

Run PROGRESS programs with this option. 

1 Select the drop-down User Menu, and choose Run Program.

2 In the pop-up window, type the program name or its full option 
number (for example, 1.4.1).

Fig. 2.7
Running a 
Program from 
the User Menu 

3 Choose OK, or press Enter.

Standard Program 

OBCM Program 
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Exit

You can exit the current program from the User Menu. From a menu 
screen, this option exits MFG/PRO. You can also exit a program by either 
of the following methods:

• Press Alt + X.

• Click on the close menus box, which is in the upper right corner of 
every program window.

PROGRESS Editor

Tip 
The PROGRESS 
editor is not acces-
sible in some 
programs.

You can access the PROGRESS editor from the User Menu while on 
menu screens by choosing PROGRESS Editor.

Edit Menu

This drop-down menu offers standard Windows editing tasks: cut, copy, 
and paste text.

Fig. 2.8
Edit Drop-Down 
Menu

Cutting, Copying, and Pasting with the Edit Menu

Cutting text deletes it from its current location and copies it to the 
Windows clipboard. Copying is the same, but it leaves the original item in 
place. In both cases, you can paste the text to another location, such as a 
field. Use the following procedure.

1 Select the item to cut or copy.

2 Pull down the Edit Menu, and choose Cut or Copy.
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Fig. 2.9
Cutting, Copying, 
and Pasting

3 Position the cursor at the new location.

4 Pull down the Edit Menu, and choose Paste.

Important   You cannot enter pasted elements through the Edit menu in 
Master Comment Maintenance (gpcmmt.p) or any of the transaction 
comment screens. You can, however, use the Cut (Ctrl + X), Copy 
(Ctrl + C), and Paste (Ctrl + V) keyboard shortcuts to a maximum of 76 
characters. You can also use the Copy and Paste icons in the tool bar.

Cutting, Copying, and Pasting (keyboard shortcut)

Cutting, copying, and pasting can be performed at the keyboard. Use the 
following procedure:

1 Select the item to cut or copy.

2 Press Ctrl + X to cut or Ctrl + C to copy.

3 Position the cursor at the new location.

4 Press Ctrl + V to paste.

Editing Images with the Edit Menu

With the Edit Image option on the Edit menu, you associate images with 
information in your database. For example, if you have an item number 
1000, you can associate an image, 1000.bmp, with the item. Then, with 
your cursor in the Item Number field and 1000 appearing in the field, you 
click on Edit Image to go into Microsoft Paint (or some other imaging 
application) to view or edit the image. 

For example, you can associate items with their pictures or purchase 
orders with scanned images of the orders. The imaging application stores 
these images in the working directory. 

Choose Cut or Copy
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This feature requires that the each code with which you associate an 
image is a legal DOS name. DOS allows a maximum of eight characters 
preceding a period and a maximum of three characters after. The 
characters before the period are referred to as the file name in the DOS 
environment; the period is the divider; the characters after the period are 
the extension. For example, auto1000.bmp is a legal DOS name.

The .bmp extension is always assumed.

Ï See Chapter 7 for 
details.

To use an imaging application other than Microsoft Paint, specify it in 
your PROGRESS initialization file.

Fig. 2.10
Editing Images

1.
Enter the item to be imaged.

2.
Pull down the Edit menu,
and choose Edit Image.

3.
MFG/PRO takes you to an 
imaging application and 
opens the picture.

1000.bmp

Item Number: 1000
 



20 MFG/PRO USER INTERFACE GUIDE
Navigate

The Navigate menu is only available in OBCM programs. Use it to access 
OBCM program folders instead of clicking on the folder tabs. Which 
options display on this menu depend on the particular program you are 
executing.

Fig. 2.11
Sample Navigate 
Menu

Config

The Config menu is available only in OBCM programs. It enables you 
to change the folder sequence and limit the folders that automatically 
display. You can use the menu in two ways:

• Select folders by name to add or delete them from the configured 
folder list. Folders that appear in the configured folder list are 
automatically displayed when tabbing through a program. Choose 
Save to preserve the configuration.

• Choose the Reconfig submenu to add and delete folders from the 
configured list and change the sequence in which they appear.

Fig. 2.12
Config Menu

Reconfiguring Folders with the Reconfig Submenu

You can change the sequence and configuration of folders in two ways:

• From the Reconfig submenu

• By clicking and dragging the folder tabs with your mouse

Configured 
Folder List
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To resequence folders from the menu:

1 Choose the Reconfig submenu.

2 The Resequence Configurable Frames screen appears.

Fig. 2.13
Changing Folder 
Order

3 In the Configurable Frames window, highlight the folder you want 
and choose Move Up or Move Down. The folders display in the 
selected order in the OBCM program window.

4 To take folders out of the configuration sequence, select them and 
change the Frame Type to On Demand. The asterisk by the folder 
name is deleted.

Fig. 2.14
Reconfiguration On 
Demand
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5 Choose Save to save the configuration for the next MFG/PRO 
session.

6 Choose: 

The OBCM program appears and the folders to which you gave the 
On Demand setting are grayed out (Figure 2.15).

7 You can open folders by single-clicking on the folder tab, but 
MFG/PRO does not automatically open them as it does a configured 
folder when you tab through the folders.

Fig. 2.15
Configured Folders

 Folder
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Options Menu

The content of the Options menu varies according to the type of program 
you are using. To turn an option on or off, pull down the menu and choose 
the option (or type its first letter). A check mark next to an option shows 
that it is on. If an option is grayed out, the option is unavailable. 

Fig. 2.16
Example Options 
Menus

Menu Substitutions

This option enables you to toggle between MFG/PRO browses and 
inquiries. You can also use it to switch between customized and non-
customized versions of a program.

Tool Bar

Ï See “Tool Bar” 
on page 30

This option turns the Tool Bar on or off. The Tool Bar appears below the 
menu bar and contains buttons to run programs.

Standard Program 

OBCM Program 
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Show Drop Downs

Show Drop Downs refers to icons for drill downs (browses), calculators, 
and calendars, which appear next to fields.

• Calendars are attached to date fields.

• Calculators are attached to numeric fields.

• Drill downs (browses) are attached to specified fields.

For example, if a calendar drill down is attached to a field, a small icon 
appears next to the field to indicate this. If Show Drop Downs is off, the 
drill down icons do not appear.

Fig. 2.17
Calendar Drill 
Down

Hide Menu Items (Standard Program Only)

When menu securities have been set for a particular user, the Hide Menu 
Items option removes all menu items to which the user does not have 
access.

Calendar Drill Down Icon

Calendar
The calendar appears when 
you click the drill down icon.
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Save Settings on Exit (Standard Program Only)

This option stores your final menu location when you exit the current 
session. When you restart MFG/PRO, you return to that menu, skipping 
the Main menu and all intermediate menus (unless you change your menu 
style when you enter MFG/PRO).

This option also stores your settings for the following:

• Menu Substitution

• Tool Bar

• Show Drop Downs

• Hide Menu Items

Read Only Access (OBCM Program Only)

This option gives you read-only access to the database record; you cannot 
make any changes. If you are updating a record when you choose Read 
Only Access, the change cannot be saved.

Note   You do not lock the record when you use the Read Only Access 
option. A locked record can only be modified by the person who locked it.

Alternate Output (OBCM Program Only)

Use this option to direct the output of the program to a file, another 
application, or directly into the MFG/PRO database. When you choose 
Alternate Output a pop-up window display, which contains the following 
options:

• No External Output—to turn off continuous output

• CIM Flat File—for CIM load

• ADI Defaults File—for alternate input, which determines 
default values

• CIM Direct Data Load—for direct load of data to CIM 
database tables

• User Defined—for loading data to programs other than MFG/PRO

• If you select User Defined, fill in Output File Name and 
Program Name
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This pop-up window also contains settings for Output Interval:

• One Time Only—for one screenful

• Individual Transactions—for processing larger amounts of data 
one screenful at a time

• Continuous—for processing larger amounts of data as a block 
(use for interdependent data)

• Process Data Interactively—if not checked, the software displays
an alert if there is not an update

Choose OK or Cancel.

Alternate Input (OBCM Program Only)

This option is not active.

Toggle Filter (OBCM Program Only)

Ï See “Filtering 
and Sorting 
Browses” on 
page 56.

Use the toggle filter setting to turn on and off the filter criteria set up in 
the browse filter options. The filter can also be turned on and off by 
selecting the Filter On/Off button in the Tool Bar. 

Browse Graphing (OBCM Program Only)

Ï See “Browse 
Graphing” on 
page 57.

Choose Browse Graphing to graph the contents of a browse. This option 
is also available by clicking the Graph button on the Tool Bar in OBCM 
programs and in the browse window. 

Window Menu (OBCM Program Only)

The Window menu lists the detail applications associated with the 
currently running program. Select the detail application from the Window 
menu as an alternative to clicking on one of the numbered buttons to the 
right of the screen.
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Help Menu

This menu gives you help on the user interface, fields, and programs. It 
also lets you view browses on selected fields. 

Fig. 2.18
Help Menu

Contents

This help file covers the contents of Field Help and Procedure/Program 
Help.

Interface Help

This help file covers the Windows interface for MFG/PRO for Windows.

Field Help

The fastest way to get help for the current field is by pressing F1, but you 
can also bring it up with the Help menu. With the cursor in the field, drop 
down the Help menu and choose Field Help.

Procedure Help

While in a procedure, drop down the Help menu and choose Procedure 
Help.
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Drill Down

Drill downs are browses accessed by clicking the drill-down button or 
by pressing Alt + F1. You use drill downs to view records available to 
specified fields; you then select a record to drag back into the field. 

Ï For more 
information, refer 
to “Browses” on 
page 51.

With the cursor in the field, drop down the Help menu and choose 
Drill Down. You can select and double-click on a record in the drill-down 
browse to include it in your current program. 

Look-Up Browse (OBCM Program Only)

You use look-up browses to view records available to specified fields; you 
then select a record to drag back into the field. They are similar to other 
browses, but contain less detail. With the cursor in the field, drop down 
the Help menu and choose Look-Up Browse.

Fig. 2.19
Look-Up Browse

To select the field you want to sort by, arrow through the choices in the 
upper field. As with drill-down browses, you can select and double-click 
on a record to include it in your current program.
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About...

This option gives you technical information about MFG/PRO. You can 
display the same information by pressing Ctrl + F1.

Fig. 2.20
Help About... 
Screen

Program Stack

You can use the program stack to display the names of the programs used 
to call the current program. Click on the right arrow to move up the stack, 
or toward the MFG/PRO main menu. The left arrow moves down the 
stack. When you reach either the top or the bottom of the stack, the 
appropriate arrow is disabled.

Version of 
MFG/PRO Version of 

PROGRESS
Menu Program

Name of program
currently executing

Program 
Stack
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Tool Bar
The Tool Bar contains buttons to launch programs and tools. If you do 
not see the tool bar on your screen, choose Tool Bar from the Options 
drop-down menu.

Table 2.1
Tool Bars in 
MFG/PRO Description  Standard Icon OBCM Icon

Copy Same

Paste Same

Field Help Same

Procedure Help Same

Drill-Down Same

Return Same

Calculator N/A

Calendar N/A

Print N/A

Browse Options N/A

On/Off N/A

Graph N/A

First N/A

Previous N/A
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Not all buttons appear on all screens. Each MFG/PRO program controls 
which ones to display. For example, the print icon is not relevant to some 
programs and does not appear in them.

Customizable Buttons

There can be up to four buttons on the left side of the tool bar in a 
standard MFG/PRO program. In OBCM programs you can define up to 
eight buttons, which appear on their own tool bar. In Figure 2.21, there 
are two buttons:

• Item Master Browse 

• Address Master Browse 

You set up these buttons with the User Tool Maintenance (36.20.2) 
program described on page 69.

Launch a program by clicking its button.

Next N/A

Last N/A

Clear N/A

Edit N/A

Delete N/A

OK N/A

Cancel N/A

Description  Standard Icon OBCM Icon
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Copy/Paste

Use these buttons to copy data between fields, in the same program or 
different programs.

Fig. 2.21
Copying from One 
Field to Another

Important   All transaction comment screens, including Master Comment 
Maintenance (gpcmmt.w), accept a maximum of 76 characters pasted 
into a line.

You can copy from and to multiple fields in one pass, as shown in 
Figure 2.22. 

1 Click the Copy button. The cursor changes to:

2 Click the field to copy:

3 Click the Paste button. The cursor changes to:

4 Click the field to copy to:

5 The data is copied:

ABC

ABC
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Fig. 2.22
Copying Multiple 
Fields

Important   All transaction comment screens, including Master Comment 
Maintenance (gpcmmt.w), accept a maximum of 76 characters pasted 
into a line.

1 Click the Copy button. The cursor changes to:

2 Click and drag around the fields to copy:

3 Click the Paste button. The cursor changes to:

4 Click and drag around the fields to copy to:

5 The data is copied:

ABC
XYZ

ABC
XYZ
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Field Help

You can display help for any field on the screen by pressing F1. Choose 
the Field Help button to display help for any field not in a pop-up box.

1 Click the Field Help button on the tool bar:

2 The cursor changes to:

3 Click a field for information. For example:

4 The Field Help screen appears.

Fig. 2.23
Displaying 
Field Help

?
Format: 0

?
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Procedure Help

You can display Procedure Help from anywhere within the program.

1 Click the Procedure Help button on the tool bar:

2 The Procedure Help screen appears.

Fig. 2.24
Displaying 
Procedure Help

Note   You can also display Procedure Help by pressing Shift + F1.
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Drill Down

You use drill downs to view records available to specified fields, then 
select a record to enter into the field.

1 Click the Drill-Down button on the tool bar:

2 The cursor changes to:

3 Click on a field. For example:

4 The drill down displays.

Fig. 2.25
Drill Downs

Return

Click the Return button to end the program and go back to the menu.

Fig. 2.26
Return Button

AB

Customer: AB

Double-click 
to bring the 
record into 
the field.

Return Button
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Program Window
Ï See 

“Maintenance, 
Report, and 
Inquiry 
Programs” on 
page 39.

The program window displays the frames (in standard programs) or 
folders (in component programs) and fields of the current program. 
Frames are grouped in boxes, which are organized into folders in OBCM 
programs. Some programs contain more folders than can fit on the screen 
at one time; they appear one after another. 

Fig. 2.27
Standard Program 
Window

Fig. 2.28
OBCM Program 
Window

Key
Folder

Data
Folder
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Message Bar
The message bar contains messages issued by each PROGRESS program. 
Figure 2.29 shows some sample messages.

Fig. 2.29
Message Bar 
(Standard Program)

PROGRESS Status Bar

The status bar contains helpful messages to guide you through your work. 
All of the options it displays can also be accessed through the User Menu.

Fig. 2.30
PROGRESS 
Status Bar
 



CHAPTER 3

Maintenance, Report,
and Inquiry Programs

This chapter covers maintenance, report, and inquiry programs. 
It includes the following topics.

Maintenance Programs     40

Report Programs     44

Inquiry Programs     50



40 MFG/PRO USER INTERFACE GUIDE
Maintenance Programs
With maintenance programs, you review, add, modify, and delete 
database records.

Starting the Program

You can start a program in a number of different ways:

• Double-click the program option on its menu. On the tear-off menus, 
a single click is sufficient.

• Click the menu selection box, type the program number, and press 
Enter. If the program appears on the current menu, simply type its 
number. 

Fig. 3.1
Menu Selection 
Box: Option 
Number

If the program appears on a different menu, call up that menu, then the 
program. For example, to run the Customer Maintenance program from 
the Main Menu:

1 Type 2, and press Enter. The Address/Taxes menu appears.

2 From the Address/Taxes menu, type 1, and press Enter. The Customer 
menu appears.

3 From the Customer menu, type 1, and press Enter. The Customer 
Maintenance screen appears.

Note   To save time, type 2.1.1 directly in the Main Menu selection box, 
and then press Enter. 

If you are currently on another branch of the menu tree (for example the 
1.4 menu), enter a period before the menu number (.36.4.4).

If you want to call up a program located on a different submenu, type a 
period (.), then type the series of menu option numbers. For example, you 
can type .5.7 to switch from the Customers Menu (2.1) to program 5.7, 
Purchase Order Maintenance.
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Note   In the Windows environment, the destination must be a program, 
not another submenu.

You can also click the menu selection box, type the program name, and 
press Enter. In the example shown below, adcsmt.r is the program name 
for Customer Maintenance.

Fig. 3.2
Menu Selection 
Box: Program 
Name

Note   To learn a program’s name, click the Help drop down from within 
the program and choose About.

Entering Key Data

The program appears with the cursor in the first field. You enter the key 
data in this field (in some programs, in more than one field). The key data 
identifies the record you want. All other fields are inaccessible until you 
enter the key data. If you are creating a new record, you enter the new key 
data and then go on to the other fields to complete the record.

Type the key data, and press Enter.

Ï See “Selecting 
Auto Go” on 
page 72.

Note   If you are using an OBCM program, the functionality of Enter 
depends on the setting of Auto-Go.

If you do not know which record you want, you can search through the 
database in three ways:

• Press the up and down arrows to cycle through the records.

• Access the look-up browse through the Help menu.

Ï See Chapter 4, 
“Browses,” on 
page 51, for more 
details.

• Drill down on the field. Drill downs are powerful tools for finding 
and analyzing data.
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Moving Around on the Screen

Selecting a record fills in the fields on the screen. For new records, these 
fields are empty and ready for your input. You advance through the fields 
with mouse clicks or keystrokes.

Fig. 3.3
Moving Around 
on a Maintenance 
Screen

The program opens one frame of data at a time. The fields in disabled 
frames are gray.

There are differences in navigating and saving data between OBCM and 
standard programs. Table 3.1 is a detailed list.

Note   Windows and Character conversion tables can also be found in 
“About This Guide” on page 1.

Ï See “Selecting 
Auto Go” on 
page 72.

In OBCM programs, some function key behavior is determined by the 
Auto-Go setting. 

Mouse
Click any field 
in the open 
frame.

Keyboard
This message 
bar defines the 
keystrokes.
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Table 3.1
Accelerator Keys 
in WindowsAction

Standard and OBCM 
Windows Programs

Standard
Character-Based

Help

Procedure Help Shift + F1

Program name Alt + A

Field Help F1 F2

Field name Ctrl + F Ctrl + F

Navigation

Forward one field Tab

Forward one field and accept input Enter

Back one field Shift + Tab

Clear field Ctrl + X F8

Next frame or folder F2 F1

Open a browse drill down Alt + F1

Open a look-up browse Alt + F2

Open Window Alt + #, where # is the underlined number on the 
window button

Exit the program (from a menu, this 
ends MFG/PRO)

Alt + X

End or Exit Esc F4

Jump to program Alt + U F6

Run program by name or number Ctrl + R

Stop program Ctrl + Break Ctrl + C

Menu F6 standard, Alt OBCM F6

Open detail application 
(OBCM only)

Alt + number on button

Editing

Add or insert record Insert, F3 F3

Delete record F5 F5

Forward one field and accept input Enter

OBCM: commit changes (OBCM)

Commit changes in last frame

F12

Enter, F2, F12

F2

Copy/paste Ctrl + C / Ctrl + V F11
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Report Programs
In this discussion, we use the Customer Master Report as our example, 
but the principles apply to all report programs. You produce a report in 
three steps:

1 Specify the report contents.

2 Select a printing device (printer, terminal, or file).

3 Print the report.

Selection Criteria

The report programs request input to select the report contents. You print 
selected records, based on your criteria. For example, you can print out 
customers for a specified salesperson or in a specified area. 

Fig. 3.4
Customer Master 
Report: Entering 
Selection Criteria

You can produce a variety of reports depending on your needs. Leaving 
all fields blank produces a report on all records.

This sample 
input produces 
a report on all 
customers with 
a post code of 
123456.
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Using Printers and Terminals

You can output reports to a printer, to your terminal, or to a file. If you 
output to file, you can open the file with a word-processing application 
for editing. 

Fig. 3.5
Printing to Printers 
and Terminals

Note   The devices listed in your Output Options screen may vary, 
depending on your system configuration.

3.
Optional.
Click here to print 
later in batch mode.

4.
Click OK.

1.
Click here to open the 
Output Options screen.

2.
Choose the
appropriate device.
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Printing to a File

You can output the report to a file. You can then import this file to a word-
processing application for reformatting or incorporation into another 
report.

Fig. 3.6
Printing to a File

1.
Click here.

2.
Click OK to open the Print to File screen.

3.
Type a file name here.

4.
Click OK.
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Viewing Reports in a Window

Use the arrows or scroll bars to scroll through the reports in your window. 
You can edit and search through the reports, as required. 

Fig. 3.7
Scrolling Through 
a Report

Opening and Saving Reports

You can open existing reports and save new ones for future reference or 
editing. Choose File from the menu bar. Open and save reports from the 
File drop down menu.

Fig. 3.8
Opening and 
Saving Reports
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Editing a Report

By default, reports are read-only, meaning that you cannot edit them 
(although you can copy text from reports to paste in other documents 
or reports).

To edit a report:

1 Turn off the read-only attribute.

Fig. 3.9
Editing a Report

2 When the read-only attribute is turned off, you can enter text and edit 
the report.

3 To cut or copy text, select the text by clicking at the start of the text 
block and dragging the cursor to the end of the text block. Choose Cut 
or Copy to capture the selected text on the clipboard. Move the cursor 
to the new position, and choose Paste to cut or copy the text at the 
new position.

Click here to turn Off the Read-Only attribute.

The check mark 
indicates that the 
Read-Only 
attribute is On.
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Searching Through a Report

To search through reports at your terminal:

1 Choose Search from the menu bar.

Fig. 3.10
Searching Through 
a Report

2 You can choose the Find Next and Find Previous options after you 
enter the search object.

1.
Choose Find to open the Find screen.

2.
Type the text to find.

4.
Click OK to search.

3.
Choose Up or Down to search 
backward or forward from the 
cursor.

Optional.
You can request the 
search to match 
uppercase and lowercase 
characters, and go back to 
the beginning when the 
report is completed.
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Inquiry Programs
Inquiry programs give you a quick look at a well-defined set of data. 
This example uses the Item Master Inquiry.

Fig. 3.11
Item Master Inquiry 
(1.4.2)

1.
Select the data to view in these fields.
Use the up and down arrow keys to 
scroll through the data.

2.
Select the output device.
Use the up and down arrow keys to 
scroll through the available devices.

3.
Press the spacebar to page through the inquiry.
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Introduction
You must have the Query version of PROGRESS to access browses.

There are two types of browses: look-up browses and power browses. 

Access a look-up browse from the Options or Help menu, click on its icon 
next to the field that it is attached to, or press Alt + F2.

Access the functions of a power browse from the Options menu, click a 
function’s icon on the tool bar, or press Alt + F1. In OBCM programs, you 
can also select the Browse folder tab. 

Browses display selected data in the form of a table. Look-up browse
return the value you select to the active field in the calling program. U
power browses to display, filter, graph, or print data.

Ï For information 
on components in 
the browse 
screen, see 
“Screen 
Elements” on 
page 13.

The field values in the browse can come from a table or a view. A view is 
a table that has selected values from one table or several joined tables. 

Look-up and power browses display several records at a time. To scroll 
through the records, click the down arrow of the scrollbar. (In a character 
interface, press page down or the down arrow.) A message occasionally 
displays, telling you that the browse is getting the next group of records.

Look-Up Browses

A look-up browse displays valid field values for the field the browse is 
attached to. It can display and sort up to seven columns of fields. A look-
up browse cannot filter, graph, or print data. Access a look-up browse 
from the Options (OBCM programs) or Help menu, click on its icon next 
to the field that it is attached to, or press Alt + F2. Attach a look-up browse 
to a field with Window Help Maintenance (36.4.21).
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To enter the cell contents of the browse in the active field of the calling 
program:

• Triple click on a browse cell (that is, one click to select the cell, two 
clicks to enter the cell data in the field)

• Select a cell, and press Enter or OK.

Browses accept wildcards (*) as a search criterion. For example, if you 
enter AD* in the field of the calling program or in the browse, it displays 
only values beginning with AD. 

Important   You could incur a serious loss of performance when you use 
wildcards to search for non-indexed fields. The browse searches the entire 
database; while it is searching, your MFG/PRO session is unavailable for 
other processing.

Users have several options for filtering look-up browses.

• If you type one or more characters in the field of the calling program 
and access the look-up browse, its display begins at the record 
starting with those characters. 

• When the browse is the active window, you can type one or more 
characters in its entry field, press Enter, and the browse display 
begins at the record starting with those characters.

• When the browse is the active window, you can click on an unsorted 
column heading (one that is in the sort-columns selection list but is 
not the current sorted column) and then type one or more characters. 
When you pause in your typing, the browse begins the search. It re-
sorts on the column heading you clicked on and redisplays, beginning 
with the record that matches your criterion.
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n’s 
Figure 4.1 shows the Item power browse and the look-up browse that is 
attached to the Item Number field.

Fig. 4.1
Item Power Browse 
and Look-Up 
Browse 

Power Browses
Ï See Figure 4.2 Power browses display up to 20 columns of fields (a maximum of 330 

characters); the first 7 columns can be sorted, the first 10 columns filtered. 
Column headings in a browse display are the field labels; rows are field 
values. Print a browse by choosing the print button on the tool bar. A 
dialog box displays where you set your output device (such as a printer or 
your monitor screen) and print to it. As with other MFG/PRO programs, 
printing cannot be canceled from MFG/PRO, but does appear in the 
Windows Print Manager, where the initiator of the print job can cancel it.

Ï See “Tool Bar” 
on page 30.

Access these functions in the Browse Options menu or click a functio
icon on the tool bar. 
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Fig. 4.2
Power Browse for 
Item Master

You can put a power browse on the tool bar as a button, assign it a menu 
number to replace an existing menu item or add a new menu item, embed 
it in an OBCM maintenance application as a Browse folder, or attach it to 
a field as a drill down. 

If one is available, you access a drill-down browse by placing the cursor 
in the field and using any of the following methods:

• Press Alt + F1.

• Select the Help menu, and then select Drill Down.

• Click the drill-down icon, and then click the field.
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Filtering and Sorting Browses
Power browses have a Browse Options button on the tool bar for 
accessing filter and sort options.

Filters limit the viewable records according to your specifications. For 
example, you can filter out product numbers or statuses that you do not 
want to view. In your selection criteria, you can filter for a range of 
values. 

You can alphabetically or numerically sort the fields in the first column of 
a browse. Select the field you want to be the first column in the Sort By 
field. 

1 Choose Browse Options on the tool bar: 

MFG/PRO displays the Browse Options window.

Fig. 4.3
Browse Options 
Window

2 Enter criteria in any of the fields. You can enter exact criteria on both 
the right and left sides, or you can use wildcards (*) in the left column 
for character fields. You cannot use wildcards for numeric fields. 
When you use a wildcard in a field in the left column, the 
corresponding To field is disabled. The To fields do not accept 
wildcards.
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Important   You could incur a serious loss of performance when you use 
wildcards to search for non-indexed fields. The browse searches the entire 
database; while it is searching, your MFG/PRO session is unavailable for 
other processing.

3 In the fields on the left side of the Browse Options window, the 
default is the lowest number or first alphabetical selection. In the 
fields on the right side of the Browse Options window, the default is 
the highest number or last alphabetical selection. 

4 In the Sort By field, choose a field (column) from which the 
records will be sorted.

5 In the Sort Order field, choose Ascending or Descending. 

6 Choose to create the filtered browse.

The filtered browse becomes active in the browse window.

7 You can toggle between the filtered and unfiltered browse by clicking 
the Filter On/Off button. Changing the sort affects filtered and 
unfiltered browses.

The status of your filter selection is displayed in the Message Bar.

Browse Graphing
You can make graphs of browse data on the screen and print them. 
Browse graphing is available only in MFG/PRO for Windows.

Fig. 4.4
Graph Selection 
Criteria
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X-Axis Data 

Select a field from the X-Axis Data box whose data you want to use as the 
tick marks on the x-axis of the graph. Click on the down arrow to see all 
of the field names. 

Y1-Axis Data

Select a field from the Y1-Axis Data box that you want to use as the 
Y-axis of the graph. Click on the down arrow to see all of the field names. 
Fields that are not numeric appear with the word count in parentheses 
following the field name. Only non-numeric data can be counted. 

For example, if you select Region in the X-Axis Data box and Customer 
(count) in the Y1-Axis Data box, the graph displays the total count of all 
customers per region.

Note   The fields that appear in the selection lists depend on the program 
selected.

Y2-Axis Data 

This is identical to Y1-Axis Data, except that it includes an entry for 
None. Select a field from the Y2-Axis Data box if you want to display 
two sets of data on the Y-Axis. For example, if you select Customer from 
X-Axis Data, Balance from the Y1-Axis Data, and Credit Limit from 
Y2-Axis Data, the resulting graph shows the customers on the X-axis 
with a graph of their balance versus their credit limit. If None is selected 
in Y2-Axis Data, only one set of data appears on the Y-axis.

Note   Pie charts can be displayed with only one set of data. Therefore, 
if Pie Chart is selected in Types of Graphs, Y2-Axis Data is disabled.
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Total, Count, Average, Minimum, and Maximum

Under the selections for Y1-Axis Data and Y2-Axis Data, a radio set lists 
Total, Count, Average, Minimum, and Maximum. One selection can be 
made for the Y1-Axis Data and one for the Y2-Axis Data. If a non-
numeric field is selected in either radio set, the associated radio set is 
disabled. The selections are as follows.

Total

Adds up all of the values for the selected Y-Axis Data field in the browse 
for each X-Axis field. For example, if Region is selected in X-Axis Data 
and Balance is selected Y1-Axis Data, the data represents the total 
balance of all customers in that region. If Customer is selected for X-Axis 
Data and Balance is selected for Y1-Axis Data, the data represents each 
individual customer’s balance.

Count

This is used primarily for non-numeric fields. It counts the number of 
occurrences of y-axis data for each x-axis field. For example, if Region is 
selected for X-Axis Data and Customer (count) is selected for Y1-Axis 
Data, the data represents the total number of customers in each region.

Minimum

Reads through all of the values for Y-Axis Data in the browse for each X-
Axis Data and selects the lowest value. For example, if Region is selected 
for X-Axis Data and Balance is selected for Y1-Axis Data, the data 
represents the lowest customer balance in the region.

Maximum

Reads through all of the values for Y-Axis Data in the browse for each X-
Axis Data and selects the highest value. For example, if Region is 
selected for X-Axis Data and Balance is selected for Y1-Axis Data, the 
data represents the highest customer balance in the region.
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Average

Adds up all of the values for this Y-Axis Data in the browse for each 
X-Axis Data and divides by the total number of occurrences of the 
Y-Axis Data. For example, if Region is selected for X-Axis Data and 
Balance is selected for Y1-Axis Data, the data represents the average 
balance of all customers in that region.

Type of Graph 

This is a radio set for selecting the type of graph format you want 
displayed. The choices are Bar Chart, Pie Chart, Line Graph, and 
Area Graph.

3-D, 2-D 

This radio set enables you to select either a three-dimensional or two-
dimensional display.

Filtered Data/Unfiltered Data 

Ï See “Filtering 
and Sorting 
Browses” on 
page 56.

This radio set lets you choose to graph just the data that was previously 
filtered in the browse or all of the records. If you want to change the filter 
criteria, you first must cancel out of this dialog box and make the changes.

Using Graph Browsing
To make a graph, do the following:

Ï See “Tool Bar” 
on page 30, for 
more 
information.

1 Access the graphing tool by selecting the Graph button on the browse 
window. 

MFG/PRO displays the Graph Selection Criteria window.

2 Select the information you want for the X-axis, Y1-axis, and Y2-axis.

The graph you create displays X-axis data by evaluating it with the 
Y-axis criteria. To display the list of possible selections, click 
the down arrow next to this field. 

3 Select the type of graph. Pie charts support a single y-axis.
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4 Select either a three-dimensional or two-dimensional display.

5 Select either Unfiltered Data or Filtered Data.

6 Choose to display the Graph window.

Fig. 4.5
Graph Window

7 If you want to redraw the graph in another format or change the 
Y1-axis or Y2-axis information, make those changes and click on the 
Redraw button on the Graph window. The graph does not refresh 
automatically.

8 Choose the Printer button if you want a printed copy of the graph.

9 To return to Graph Selection Criteria, choose the Cancel button.

10 If you move or cover the window, choose the Redraw button to 
redisplay the graph.

11 If there are too many data points to graph, the labels do not appear 
across the X-axis. All of the data points are plotted, but the labels do 
not appear (just tick marks).

35
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Customer Browses by Site
Customer Count

Redraw Button
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Graphing Examples

Four examples are presented here to give you some ideas for using 
Browse Graphing. Which fields appear in the selection lists depends 
on the program selected.

Example 1

1 Select the following:

X-Axis Data: Region

Y1-Axis Data: Customer (count)

Y2-Axis Data: Salesperson[01]

Type of Graph: Bar Chart

3-D

Unfiltered Data

2 After making your selections, click OK and the graph displays each 
Customer Region across the x-axis.  

The red bars represent the Customer Count, and the blue bars 
represent the Salesperson Count.  

3 Click Cancel to return to the Graph Selection Criteria dialog box.

Example 2

1 Select the following:

X-Axis Data: Customer

Y1-Axis Data: Balance

Type of Data: Total

Y2-Axis Data: Credit Limit

Type of Data: Total

Type of Graph: Bar Chart

2-D

Filtered Data
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2 After making your selections, click OK and the graph displays each 
Customer across the x-axis. 

The red bars represent the Customer’s Balance, and the blue bars 
represent the Customer’s Credit Limit.  

3 Change the Bar Graph to a Line Graph in the Graph Type radio-set.

4 Click the Graph button again.

The same information redisplays in a Line Graph format. The solid 
red line represents the Balances and the dotted blue line represents the 
Credit Limits. 

5 Click Cancel to return to the Graph Selection Criteria dialog box.

Example 3

1 Select the following:

X-Axis Data: Salesperson[01]

Y1-Axis Data: Customer (count)

Type of Data: Count

Y2-Axis Data: None

Type of Graph: Pie Chart

3-D

Unfiltered Data

2 After making your selections, click OK and the graph displays a 
Pie Chart with each piece of the pie representing the Total Number 
of Customers per Salesperson. 

The Salesperson’s code and the total count per Salesperson display 
beside each piece. The percentage that each slice represents is 
displayed inside the pie. 

Note   Pie Charts only work if Y2-Axis Data is set to None and there are 
fewer than 12 values to display. 

3 Click Cancel to return to the Graph Selection Criteria dialog box.
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Example 4

1 Select the following:

X-Axis Data: Salesperson[01]

Y1-Axis Data: Balance

Type of Data: Total

Y2-Axis Data: Credit Limit

Type of Data: Total

Type of Graph: Bar Chart

3-D

UnFiltered Data

2 After making your selections, click OK and the graph displays each 
Salesperson across the x-axis. 

The red bars represent the total of all of the Customer’s Balances
for each Salesperson, and the blue bars represent the total of all 
the Customer’s Credit Limits for each Salesperson.  

3 Change the Data Type from Total to Average, Minimum, or 
Maximum on both Y1-Axis Data and Y2-Axis Data. 

4 Click the Graph button again.

Note how the x-axis stays the same while the values on the y-axis
change. 

5 Click the Print button to print the graph. 

Note   Graphs are printed using the normal Windows printers, rather t
the MFG/PRO printers.

6 After printing, click Cancel to return to the Graph Selection Criteria 
dialog box.
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Introduction
With MFG/PRO for Windows, you have a broader range of control over 
the user interface (UI) than with the character-based product. The 
interface control is located in the UI: Manager Functions menu (36.20).

Ï See the Network 
User Interface 
Guide for details.

Note   If you are using the Network User Interface for the Java platform, 
additional programs support customizing the Web interface (36.20.10).

Maintaining Drill Downs

Drill Down Maintenance (36.20.1) is the first option on the UI: Manager 
Functions menu.

You can assign drill downs to fields that do not have a drill-down browse, 
replace a browse, or delete one.

Drill downs are power browses attached to fields. Drill downs quickly 
access greater detail on valid entries for the fields, like master file items 
or generalized codes. If more than one browse is attached to a field, a 
small menu of browses appears.

Before you can use this program, you need to know the name of the field 
to attach the browse to, the name of the field’s program, and the prog
name of the browse to attach.

Ï See “Creating 
Browses” on 
page 86, for 
details on 
creating browses.

To determine the name of the field and program, run the program. Select 
About… from the Help menu. The dialog box gives you the program 
name. Return to the program and click on the field that you want to at
the browse to. Press Ctrl+F and note the field name. 

Fig. 5.1
Drill Down 
Maintenance 
(36.20.1)
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You can assign more than one drill down to the same field. A menu of 
drill downs appears when you request the drill down.

You can attach browses to fields in any program, including another 
browse. Drill downs can be nested: a field can call a browse that can call 
another browse that can call another browse, and so on.

Follow these steps to use Drill Down Maintenance to associate a drill 
down with a field or program.

1 Enter a field name to associate with the drill down in Field. Leave it 
blank to associate it with all fields.

2 Enter the program containing the field in Calling Procedure. 

3 Enter the browse name in Procedure to Execute.

4 Enter a description. Use a hyphen (-) as a qualifier. Do not use 
commas.

5 Choose  to save.

You can access drill downs in four ways:

• Select Drill Down from the Help menu and click on the field.

• Select the Drill Down icon on the tool bar and click on the field.

• Double-click on the field in the browse.

• Select the field and press Alt+F1.

Wildcards in Drill Down Maintenance

Use wild cards to attach browses to fields in multiple programs. For 
example, pp*.p attaches the drill down to the specified field in all 
programs starting with pp and ending with a .p extension.

Possible entries to Drill Down Maintenance:

Field ad_addr ad_addr ad_addr

Calling 
Procedure

* so* soivmt.p

Procedure to 
Execute

adbrad.p adbrcs.p arbrbl.p
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When you drill down on ad_addr in soivmt.p, a menu shows all three 
browses: adbrad.p, adbrcs.p, arbrbl.p. When you drill down on 
ad_addr in a program other than soivmt.p but beginning with the 
letters so, a menu shows two browses: adbrad.p and adbrcs.p. When 
you drill down on ad_addr anywhere else, the browse adbrad.p opens.

Fig. 5.2
Wildcards in Drill 
Down Maintenance

Drilling Down on Drill Downs

You can nest drill downs. In other words, one drill down can call another, 
which can call another, and so on. After creating the first drill down, you 
can assign the others to the same field. Enter the name of the first drill 
down as the calling procedure for the nested drill down.

Fig. 5.3
Nested Drill Downs First drill down

Nested (subsequent) 
drill downs

Enter the 
name of 
the first drill 
down as 
the calling 
procedure for
the nested drill
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Assigning Buttons to the Tool Bar 
and User Menu
With User Tool Maintenance (36.20.2), you can create tool bar buttons to 
run programs. This makes it easier for you to run frequently used 
programs.

MFG/PRO is delivered with buttons on the tool bar in each program. With 
most programs, you can assign up to four buttons and four User Menu 
items to launch programs of your choice. In OBCM programs, you can 
assign up to eight buttons and eight User Menu items. The buttons are 
included in the tool bar on standard MFG/PRO programs and on a 
separate bar in OBCM programs. Any standard and configured browses 
are suitable. 

You assign programs to buttons by user and program. You can change 
the buttons for all users or only some. By default, programs assigned to 
buttons are also assigned to the User Menu.

Fig. 5.4
User Tool 
Maintenance 
(36.20.2), Programs 
Folder 

1 Enter a user ID or leave the field blank to assign to all users.

2 Enter a program name or leave the field blank to assign to all 
programs.

3 In the Exec fields, enter the program names (for example, adcn001) 
for the buttons to launch.
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4 In the Label fields, enter the button labels, which you can write as 
abbreviated program names (for example, Cust Maint).

5 In the Image fields, enter the bitmap image file names. The image file 
must be in the user’s PROPATH.

6 Choose the User Fields folder.

Fig. 5.5
User Tool 
Maintenance, User 
Fields Folder

7 User fields are customizable fields. MFG/PRO logic does not refe
these fields.

8 Choose to save.

Setting Up Menu Substitutions
Use Menu Substitution Maintenance (36.20.3) to set up a link betwee
two programs so that when users select one from a menu, they get th
other. This is useful for substituting custom versions of existing progra

Each user can turn menu substitution on or off in the Options menu o
from User Interface Profile (36.20.4). 

Menu substitution also toggles browses and inquiry programs. If you h
not purchased PROGRESS Query, you cannot execute the browse 
programs. In this case, you must use menu substitution to invoke the
equivalent inquiry programs.
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Fig. 5.6
Menu Substitution 
Maintenance 
(36.20.3)

1 Enter the program name in Execution File. Users selecting this 
program from a menu will actually be running the one entered into 
the New Execution File field.

2 Enter the substitute program name in New Execution File. This is the 
name of the program to replace the one entered in Execution File. 
Users will run this program when they select the one entered in the 
Execution File field. You can use wild cards. For example, if you 
want to replace all inquiry programs with the browse versions, you 
enter *iq* in the Execution File field and *br* here.

3 Enter the label for the substitute program to display in Selection 
Label.

4 Choose  to store.

Setting Up User Interface Profile

Use User Interface Profile (36.20.4) to define default values for each user.

In Userid, select a user or group of users, or leave blank for all users. For 
that user or users, select:

• System tool bar position

• User tool bar position and whether to display it

Ï See “Selecting a 
Menu Style” on 
page 73.

• Menu style 

• Background window color

Ï See “Selecting 
Auto Go” on 
page 72.

• Auto Go setting 

• Appearance of online help. Select WinHelp? for Windows-style 
help files. The default is the standard format.
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• Whether menu substitution is enabled or disabled

• Choose to save.

Fig. 5.7
User Interface 
Profile (36.20.4)

Selecting Auto Go

Select Auto Go? to change the actions of some navigation keys in OBCM 
programs (see Table 5.1 and Table 5.2).

Table 5.1
Auto Go Selected

Table 5.2
Auto Go 
Not Selected

 

F2 (Windows)
F1 (Character) Enter F12

Key folder edit edit edit

Data folder next folder next folder commit

Last folder commit commit commit

F2 (Windows)
F1 (Character) Enter F12

Key folder next folder — edit

Data folder next folder next folder commit

Last folder next folder next folder commit
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Selecting a Menu Style
There are three menu styles you can use with MFG/PRO: 

• The icon menu style has large buttons that lead you into the different 
parts of the system and show you a hierarchy of your location in a 
submenu.

• The tear-off menu style enables you to choose your menu layout.

• The character-based menu style emulates the traditional character 
terminals.

Icon Menu Style

Tip 
The Custom button 
has no programs; it 
is for programs you 
write.

This is the default style. It has seven large buttons, each with a graphic 
image of the functional area it represents:

Distribution Master Files

Manufacturing Custom

Financials Supply Chain

Service/Support

Click a button to display its associated menu items. As you select menus 
from this screen and options from those menus, the menu screen displays 
your progress.

Fig. 5.8
Selecting Options 
on the Icon Style 
Main Menu

Clicking on the Master Files button displays these options.

Double-click the 
options to run the 
programs, or type 
the option number 
here and press 
Enter.
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Icon Menu Style Submenus

The icon-style submenus give you a map of your location in the system 
and show how you arrived there.

The buttons on the left show how you arrived where you are. Click them 
to retrace your steps. 

Fig. 5.9
Icon-Style 
Submenus

Click here or press Esc to
return to the Sign-On 
screen.

Click here to 
exit MFG/PRO.

These buttons show you how you got there. Click these 
buttons to retrace your steps.

Main Menu

Master Files

1 - Items/Sites

1.4 - Item Data Menu

At the Main Menu you 
selected Master Files.

From Master Files you 
selected Items/Sites.

From Items/Sites you 
selected Item Data.

This button is grayed-
out because it shows 
the current screen.
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Tear-Off Menu Style

The tear-off Main Menu displays buttons for each functional area of 
MFG/PRO.

Click an option to display it. Once in a submenu, you can also type the 
option number in the menu selection box and press Enter. 

Fig. 5.10
Tear-Off Menu

Menu Selection Box The symbol means that 
the option has a submenu.
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Tear-Off Submenus

Each tear-off menu remains on the screen as you select submenus. This 
means that you can choose any option from any menu on the screen. 

Fig. 5.11
Tear-Off Style 
Submenus

Click here to 
close the menu.

Press Esc to return to 
the Sign-On screen.

or
  



INTERFACE MANAGEMENT 77
Character-Based Menu Style

MFG/PRO for Windows retains a character-based version of its 
traditional menu system.

To select an option, double-click it or enter the option number in the menu 
selection box and press Enter.

Fig. 5.12
Character-Based 
Main Menu

From the character-based main menu, press Esc to return to the sign-on 
screen.

Assigning Security to OBCM Programs
Use Window Config and Security Maint (36.20.5) to set user access to the 
OBCM programs, folders, and fields. You can set program security to a 
level lower than the initial definition, change folder tab labels, and 
determine the sequence in which folders appear.

Window Config and Security Maint cannot increase a user’s access level; 
it can only decrease access levels. Access, folder tab labels, and folder 
sequence are initially defined when the program is developed, either the 
original program developed by QAD or a program developed or modified 
by the customer. Programs are developed and modified using the 
Component Configurator tool set (36.20.13). 

Menu Selection Box
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t 
To determine the components and other information of a currently 
running OBCM application, choose About…  from the Help menu and 
select the Revision button. The OBCM Diagnostic Dashboard displays. If 
you have the advanced tool set available, choose the Advanced button to 
see information on the internal components of the current application. To 
make the advanced diagnostics tool set available, go to the MFG/PRO 
section of the Windows-client MFG/PRO.ini file and set 
dashboard=yes prior to running MFG/PRO.

Security Levels

There are three levels of user access:

• Write access allows a user to update fields (this is the default level for 
most programs).

• Read-only access allows a user to see the program’s fields but no
update them.

• No access denies the user the ability to update or see the fields.

For read-only and no-access levels, security is downward effective. For 
example, if a program has read-only access, then all folders and fields 
within that program are also read only. Write-access security can be 
overridden at a lower level so that users have read-only or no access to 
fields within a write-access folder. 

You set write or read-only access for programs with Window Config and 
Security Maint. To give a user a no-access security level to a program, use 
Menu Password Maintenance (36.3.1). 

Folders and fields can have write, read-only, or no-access security.
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Setting Window Read-Only or Write Access

1 In the Security folder, enter the container ID (the program name) 
whose access you want to set for the user you enter in Userid/Group. 
The user can be an individual or group. Leave the field blank to apply 
the security setting to all users.

Fig. 5.13
Window Config 
and Security Maint 
(36.20.5), Security 
Folder

2 Enter the language code. 

3 Select the processing-level access. Choose whether the user can 
update or delete records. If you do not select any access, the user has 
read-only access.

4 Select a Read or Write configuration level. Selecting Write lets a user 
configure an individual version of the program.

5 Check Hidden Fld Labels? to hide from users the fields they cannot 
access. 

6 Select 2-Folder Detail to set security at the folder level. 
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nu.

der 
rs 
h 
Fig. 5.14
Window Config 
and Security Maint, 
Frame Folder

7 Enter the Business Group, which is a set of related folders within a 
program. Business groups control the initial definition of access 
levels. They are defined in the Groups application of Container 
Maintenance (36.20.13.13).

8 In Data Folder, enter the file name of the OBCM data folder whose 
access you want to restrict.

9 For Folder Type, select Configured for folders that you want to 
automatically display when users cycle through folder tabs. Select On 
Demand for folders that you want users to select for themselves by 
clicking on the tab or by selecting them from the Navigate menu. For 
example, in Figure 5.14, the Browse folder is an on-demand folder, 
which is indicated by its dark gray tab. 

10 Select the level of folder security.

11 In Folder Label, enter or edit a folder label, which can be up to 24 
characters. This appears on the folder’s tab and the Navigate me

12 For Folder Order, enter an integer value greater than 10 for the or
in which you want this folder to appear in relation to the other folde
in the program. The value of 10 is assigned to the key folder, whic
must appear first.
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Fig. 5.15
Window Config 
and Security Maint, 
Field Access Folder

13 Select the Field Access folder of 2-Folder Detail to set security at 
the field level.

14 To enter all the field names you want to be read-only, select the 
Add button to the right of the Read Only Fields list and enter the 
field names in the Add List Item dialog box, separating them with 
commas. 

15 Choose  to add them to the  list. 

16 To enter all the field names you want to be no-access, select the 
Add button to the right of the No Access Fields list and enter the 
field names in the Add List Item dialog box, separating them with 
commas. 

17 Choose  to add them to the list.
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Creating Views
Use View Maintenance (36.20.13.12) to create or modify views.

A view is a display of some or all of the fields from one or more tables. 
You join two or more tables for a view by specifying the relationships (in 
other words, the linking comparisons) between fields in different tables. 

Views are used in browses, which display the fields gathered using views. 
By choosing which fields to include (or exclude) in a view, you control 
which fields are available for a browse to display. By putting password 
security on the view, you can allow users to modify browses, knowing 
that they can access only those fields that you have authorized.

You use some PROGRESS syntax in creating or modifying views. You 
must also understand MFG/PRO table and field relationships.

To create or modify a view:

1 Select the table or tables to include in the view.

2 Join the tables using PROGRESS logic.

3 Select fields from the tables.

4 Save the view.

Figure 5.16 and Figure 5.17 display graphic examples of how to create a 
view of selected fields from one table or two.
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Fig. 5.16
Creating a View by 
Joining Two Tables 

Fig. 5.17
Creating a View 
from One Table

Payroll

Period

Emp ID Dept Phone Sal

Emp ID Emp Name Dept Sal

Indexed Join

Fields to Display in View

(Phone List View)Fields to Display in View

Phone

Emp ID Total

Earnings

(Employee 
Earnings View)

Emp ID Emp Name Dept Salary

(Table emp_mstr)

Employee Department List
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Fig. 5.18
View Maintenance 
(36.20.13.12), 
View/Join Data 
Folder

1 In the first window, 1-View, select or enter a view name in Name.

2 Press Go.

3 Enter a description of the view.

4 In Security Groups, enter a user ID to limit user access to the view 
(optional). You can enter multiple user IDs by separating them with 
commas.

5 Select the 2-Tables button.

Fig. 5.19
View Maintenance, 
Table Selection 
Folder

6 The number you enter in Sequence controls the order in which 
the table defined in Table is joined to the view.
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7 Press Go.

8 Enter or edit the phrase to join the tables. Use proper PROGRESS 
syntax. Do not include a Where verb. Join phrases express the field 
relationships between tables (see Figure 5.16). For a faster display of 
fields, use indexed fields in the Join Phrase.

9 Select the 3-Fields button.

Fig. 5.20
View Maintenance, 
View Field Data 
Folder

10 In Field Name, enter a field from one of the tables in the view or enter 
a local variable. When entering a local variable, name it local-
varnn, where nn is a number incremented by one from the last 
defined variable. For example, you see from the look-up browse that 
the last local variable was local-var05; you name your local 
variable local-var06. Use local variables when you want to return 
a value resulting from an operation on two fields; for example, the 
quantity required minus the quantity open. Define the operation in 
Expression.

11 If you entered a local variable in Field Name, enter its Label, Format, 
and Data Type.
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12 If Field Name is a local variable, you can enter PROGRESS syntax in 
Expression to define the local variable. Valid expressions include:

• field1 + field2 (computation, where field1 and field2 
are fields within the record).

• >, <, >= (operands that perform comparisons).

• PROGRESS functions, such as substring (field1,1,4) or 
round (field1,1).

Incorrect syntax terminates your MFG/PRO session if you attempt to use 
the view.

13 Choose  to save your changes.

Creating Browses
Ï See “Browses” 

on page 51.
Use Browse Maintenance (36.20.13.10) to create browses, which display 
selected data in the form of a table.

When you create a browse, it is saved in your working directory as a 
source-code file whose name is the first two characters of the name you 
entered, then the letters br or lu (depending on whether you selected 
power or look up), then any remaining letters from your name, then the 
extension .p. For example, you create a power browse and name it 
123456; the system names the code 12br3456.p. If you selected both 
power and look-up browses, the system generates two source-code files: 
12br3456.p and 12lu3456.p.

Although you do not need to compile the source code of the browse, you 
should for better performance. If other users on your network want to use 
your browse, you must compile it and move it to the network directory. 
Select the PROGRESS editor from the user menu to compile the browse. 

Note   You can access the PROGRESS editor from the user menu only if 
your propath is correctly set up to access source files.
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Fig. 5.21
Browse 
Maintenance 
(36.20.13.10), 
Browse Data Folder

To create or modify a browse:

Tip 
Use existing 
MFG/PRO module 
mnemonics or 
make up your own.

1 In the fields of the Browse Data key folder, name the browse and 
select a Language Code. To name the browse, enter two letters and 
press Enter. The system gives the browse a name that increments by 
one the number in the file name of the last browse created.

2 Press Go or select the edit icon to navigate to the data folder.

3 Enter a description. This description appears above the browse 
window, at the top of the on-demand report window, in the Drill 
Down description, and in the Menu Substitution label. 

4 In View, enter the name of an existing view or a primary table whose 
data the browse displays. You can see only those views you have 
access to (views where your user ID is in the password list). If a view 
exists for a table and the view name is the same as the table name, you 
have access to only those fields that are available in the view.

Note   You must have already defined in View Maintenance the view 
name you enter in View, or you must enter a primary table name.

5 In the Where field, type the selection criteria (optional) to limit the 
browse’s search to records that meet a certain condition. The criteria 
in Figure 5.21 would display only inventory balances of bolts greater 
than 100. Do not put a period (.) at the end of the criteria, because the 
system adds a no-lock no-error statement to the criteria.

If you are using MFG/PRO in character mode, go to step 13.
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6 In MFG/PRO for Windows, select the Field Select folder.

Fig. 5.22
Browse 
Maintenance, Field 
Select Folder

7 Fields from the view or primary table, which you entered in the 
Browse Data folder, appear in Available Fields. Include up to 20 
fields in your new browse by clicking on fields and choosing the Add 
button. 

8 If you want to remove a field from the Selected Fields list, select it 
and choose the Remove button.

9 You can use the To Top, To Bottom, Move Up, and Move Down buttons 
to arrange the fields in the Selected Fields list or you can order the 
fields using the Value-Returned Column. Use the Value-Returned 
Column to enter the column number whose field value you want 
entered in the active field of the calling program. It must be a number 
from 1 through 7. The default is the first column of the browse. When 
you have arranged the fields in the order you want, press Go.

10 The Sort Columns field is enabled only for look-up browses.

11 In the Sort Columns field (in the Field Select folder), enter the 
columns that you want to have available to sort on. Enter the columns 
as a comma-delimited list of up to seven numbers. The first field 
name in the Selected Fields list is column 1, the second is column 2, 
and so on. 
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12 The look-up browse sorts the records on the first column you enter in 
the Sort Columns field. The remaining columns you enter are listed in 
the selection list above the browse. Select another column in the list 
and the browse re-sorts on that column. When it re-sorts, the browse 
redisplays beginning at the first record. The browse does not 
redisplay beginning at the record that was selected when the re-sort 
was initiated. By default, the browse sorts on the first field in the 
Selected Fields selection list. 

Note   Instead of the 2-Fields, Field Select folder, you must use the 
2-Fields, Browse Field Data folder in character mode. The Browse Field 
Data folder is useful in MFG/PRO for Windows to control the sequence 
of the tables and to alter the labels and format. 

If you are using MFG/PRO for Windows, go to step 14.

13 In character mode, select the 2-Fields button.

Fig. 5.23
Browse 
Maintenance 
(2-Fields) 

14 Identify the table and field, type in the display format you want 
(character, integer, decimal, logical, or date), sequence of field, 
column in the display, and change the default field label and format.

15 Select the 1-Browse button.

16 Click on the Preview button to look at the new browse.

Important   Previewing a browse can be a time-consuming process 
because the system generates and displays the browse in runtime.
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17 If the fields, column labels, and data of the browse are acceptable, 
press Go. If the browse is not acceptable, return to the Field Select 
folder or 2-Fields application to rearrange the fields.

18 Choose  to save.
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How MFG/PRO Is Organized
MFG/PRO has 36 modules on the character-based Main Menu. In turn, 
each module has one or more menus attached to it. Menus are lists of 
programs you use to look up or input data. 

Module menus are usually nested. In other words, they contain one or 
more lower-level menus. Three kinds of programs display on menus.

• Maintenance. These programs enable you to add, delete, or change 
data.

• Inquiry. These programs enable you to select individual records and 
review them on the terminal. 

• Report. These programs enable you to select ranges of records and 
send them to a printer or file.

You cannot change information from an inquiry or report program.

You can send all inquiries to a printer or file. You can also view most 
reports on your terminal. However, reports are often too wide to display 
properly on your screen.

Fig. 6.1
Main Menu in 
Character Mode
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Program Interface Elements
The following figures are examples of MFG/PRO programs in character 
mode, using OBCM and standard programs. The OBCM programs are 
MFG/PRO maintenance programs that have been enhanced by rewriting 
them with object-oriented technology. 

Fig. 6.2
Standard Program 
in Character Mode

Fig. 6.3
OBCM Program in 
Character Mode

PROGRESS
Status Bar

Title Bar

Program Window

Title Bar

Program Window

PROGRESS
Status Bar

Menu Bar
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The content of the user interface is explained in the following sections:

• Title Bar

• Program Window

• Menu Bar

• PROGRESS Status Bar

Title Bar

The title bar describes the program you are running. Standard programs 
include their menu numbers in the title bars, but OBCM programs do not.

Program Window

The program window displays the folders and fields of the current 
program. Programs are your bridge to the MFG/PRO database. 
MFG/PRO programs contain the following interface elements.

Fields

A field is a piece of data that is stored discretely in the database. 
The system expects you to enter a certain kind of data in the field. 
For example, a field labeled Customer would store only codes for 
customer address records. Usually, you can enter or change data in a field, 
but sometimes the field displays system-generated data. If the system 
administrator has secured a field (that is, restricted user access) and you 
do not have access, you can see the field value but cannot update it or 
position the cursor in that field.
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Frames and Folders

When you look at a program screen, you will see a group of fields. 
Fields are highlighted in color (lighter or darker), in reverse video, or 
underlined, depending on your terminal. This group of related fields is 
called a frame in a standard program. In an OBCM program, it is called a 
folder. You can enter or change data only when you are in that frame or 
folder. 

You can configure OBCM programs to display the folders in the order 
that best serves your needs. In some programs, there are more folders than 
can fit on the screen at one time. Folders that cannot fit on the screen 
appear one after another. If all the fields in a folder are secured and you do 
not have access privileges, the cursor cannot enter the folder.

Menu Bar

In character mode, OBCM programs have a menu bar that you can use to 
perform various tasks.

The drop-down menus associated with each item are described in detail in 
this section. Choose the drop-down item, and choose an item by pressing 
the arrow keys, or press the underlined letter and Enter. For example, 
pressing N + Enter calls up the Navigate menu.

Fig. 6.4
OBCM Program 
Menu Bar 

User Menu

The User Menu provides access to:

• User Menu Items

• User Tool Bar Items

• Print Options

• Run Program

• Exit

User Menu items (for example, Item Master Browse and Address Master 
Browse) are user defined; you can use them to jump to other programs.

User Menu Edit WindowNavigate Config HelpOptions
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Fig. 6.5
User Menu in 
Character Mode

Running a Program from the User Menu

Run PROGRESS programs with this option. 

1 Choose the drop-down User Menu, and choose Run Program.

2 In the pop-up window, type the program name or its full option 
number (for example, 1.4.1).

3 Press Enter.

Exit

You can exit the current program through the User Menu. From a menu 
screen, this option exits MFG/PRO. You can also exit programs by either 
of the following methods.

• Press F4

• Press Ctrl + E
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Edit Menu

This drop-down menu enables you to cut, copy, and paste text.

Fig. 6.6
Edit Drop-Down 
Menu

Cutting text deletes it from its current location and copies it to the 
clipboard. Copying is similar, but it leaves the original item in place. In 
both cases, you can paste the item to another location, in the same file, or 
another file. 

1 Choose the item.

2 Display the Edit Menu.

3 Choose Cut or Copy.

4 Put the cursor in the new location.

5 Choose Paste.

Important   You cannot enter pasted elements through the Edit menu in 
Master Comment Maintenance (gpcmmt.p) or any of the transaction 
comment screens. You can, however, use the Paste (Ctrl + V) keyboard 
shortcut to a maximum of 76 characters.
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Navigate

Navigate provides an alternative way of accessing an OBCM program
folders of information, instead of cycling through the folders with F1.

Folder names that are all uppercase are configured.

Folder names that have initial capitals only are on demand. Folders th
are on demand can only be accessed through the Navigate menu.

Fig. 6.7
Example Navigate 
Menu in Character 
Mode

Config

The Config menu enables you to change the folder order and limit the
folders that are automatically displayed. You can use the menu in two
ways:

• Choose folders by name to add them to or delete them from the 
configured folder list, then choose Save to preserve the configuration.

Note   Use F1 to display the configured folders in a program.

Ï See “Using the 
Reconfig 
Submenu” below.

• Choose the Reconfig submenu to add and delete folders from the 
configured list, and change their order. 
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Fig. 6.8
Example Config 
Menu

Using the Reconfig Submenu

To change the order and configuration of folders, do the following:

1 Choose the Reconfig submenu.

2 In the Resequence Configurable Frames window, highlight the folder 
you want and choose Move Up or Move Down. The folders are 
arranged in the selected order in the OBCM program window.

3 To take folders out of the configuration, select them, and change 
the Frame Type to On Demand. (The asterisk by the folder name is 
deleted.)

4 Choose Save to save the configuration for the next MFG/PRO 
session.

5 Choose OK. 

The OBCM program appears and the folders to which you gave the 
On Demand setting are not checked. You can access On-Demand folders 
only through the Navigate menu and not by cycling through the program 
with F1.
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Options Menu

The contents of the Options menu varies according to the type of program 
you are using. To turn an option on or off, pull down the menu and click 
the option, or type its first letter. A checkmark next to an option shows 
that it is active. 

Fig. 6.9
Options Menu in 
Character Mode

Menu Substitutions

This option enables you to toggle between customized and non-
customized versions of a program.

Read-Only Access

This option gives you read-only access to the file. In other words, you do 
not lock the file. If you are updating a record when you select Read-Only 
Access, the program cancels the update.

Alternate Input

Not active.
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Alternate Output 

Ï See User Guide 
Volume 11: 
Manager 
Functions for 
details on CIM. 

Use this option to direct the output of the program to a file, another 
application, or directly into MFG/PRO. When you select this option 
a pop-up window is displayed, which contains the following options.

• No External Output—to turn off continuous output

• CIM Flat File—for CIM load

• ADI Defaults File—for alternate input, which determines 
default values

• CIM Direct Data Load—for direct load of data to CIM 
database tables

• User Defined—for loading data to programs other than MFG/PRO

• If you select User Defined, fill in Output File Name and 
Program Name

This pop-up window also contains settings for Output Interval.

• One Time Only—for one screenful

• Individual Transactions—for processing larger amounts of data 
one screenful at a time

• Continuous—for processing larger amounts of data as a block 
(use for interdependent data)

• Process Data Interactively—if not checked, the software displays 
an alert if there is not an update

Press Enter to save the settings, or F4 to cancel.

Toggle Filter

Ï See “Filtering 
and Sorting 
Browses” on 
page 56. 

Use the toggle filter setting to turn on and off the filter criteria set up 
in the browse filter options. Remember to substitute the character mode 
function keys for the Windows buttons.
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Help Menu

This menu gives you help on procedures and fields, and enables you to 
display drill downs and scrolling windows on selected fields. 

Fig. 6.10
Help Menu

Note   Although Contents and Interface Help appear on the Help menu, 
they are not available in character mode.

Field Help

The fastest way to get help for the current field is by pressing F2 twice 
(press F2 once and, if available, a look-up browse displays), but you can 
also bring it up with the Help menu. With the cursor in the field, drop 
down the Help menu and choose Field Help.

Procedure Help

While in a procedure, drop down the Help menu and choose Procedure 
Help. You can also press F2 again when field help is displayed. 
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Drill Down

Drill downs are browses accessed by choosing Drill Down on the menu. 
You use drill downs to view records available to specified fields. You then 
choose a record to enter in the field. 

With the cursor in the field, drop down the Help menu and choose 
Drill Down. 

Ï For more 
information, see 
“Browses” on 
page 51. 

Highlight the record you want by pressing the up and down arrow keys. 
Select the record by pressing Enter.�Remember to substitute the character 
mode function keys for the Windows buttons. 

Look-Up Browse

You use look-up browses to view and sort records available to specified 
fields. You then choose a record to enter in the field. With the cursor in 
the field, drop down the Help menu and choose Look-Up Browse.

To select the field you want to sort by, arrow through the choices in 
the upper field. Select the record by pressing Enter.

About...

This option gives you technical information about MFG/PRO. You can 
display the same information by pressing Esc+M, H, A. 

PROGRESS Status Bar

The status bar contains helpful messages to guide you through your work. 
In OBCM programs, all of the options it displays can also be accessed 
through the User Menu.
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Moving Between Menus and Programs
MFG/PRO is organized by menu and program. For example, Figure 6.11 
shows where the Item Tag Create program is located on the Physical 
Inventory menu.

Fig. 6.11
Submenu and 
Program

Near the bottom of every menu screen, you will see a menu command 
prompt:

Table 6.1 shows the commands you can enter in this prompt to move 
between menus and programs. 

Please select a function.
F4 or blank to EXIT. ___________________
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Table 6.1
Navigating Menus 
and Programs in 
Character Mode

Moving Around Programs

Table 5.1 and Table 5.2 on page 72 list the commands for working with 
fields and folders in programs. For many actions, there are two sets of 
keys available. For example, for function key F1, press Ctrl + X.

At any given time, only certain commands work. The status line at the 
bottom of the program screen displays all active function keys for a 
highlighted field. For example, when you are in a field from which you 
can delete an entire record, the Delete command is displayed at the bottom 
of your screen. 

On terminals that do not have function keys, use the equivalent control 
key combinations. 

Note   To permanently save data in an MFG/PRO OBCM program in 
character mode, press F12 or F1 (when in the last folder of the program).

Action Command Example

Go to a menu. Enter the menu number. 4 for Physical Inventory Menu.

Go to a program. Enter the program number. If an 
error displays, enter a period in 
front of the program number. The 
period is necessary if you are 
accessing an item from a 
different submenu.

1 for Item Tag Create (4.1).

Use the arrow keys to highlight 
the program, then press Enter.

From menu 4, use the arrow to 
highlight Item Tag Create, then 
press Enter.

Enter the PROGRESS program 
name. The .p is optional.

piptcr.p or piptcr for Inventory 
Tag Create.

Return to the last 
menu level.

End.

Press F4 or Ctrl + E.

From 4.1, you return to either 
the Physical Inventory menu or 
the Main Menu, depending on 
where you started.
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Getting Help
MFG/PRO provides two help tools.

• Scrolling Windows

• Online Help

You access all help by pressing F2 successively. First, a look-up browse 
appears (if there is one), then the field help, and then the procedure help.

Online Help

Procedure help describes the program and how it is used in the module. 
Field help describes a specific field and how it is used in the program. 
Currently, procedure help is generally available only for maintenance 
programs. Field help is generally available for input fields but not 
display-only fields.

Data Entry
You enter data in maintenance programs. When you open a maintenance 
program, the cursor appears in the first field. You enter the key data in this 
field (in some programs, in more than one field).

Key Data

The key data, such as customer number, identifies a new record or an 
existing record. All other fields are inaccessible until you enter the key 
data.

• If you are creating a new record, either type a new key value or, 
in some programs, leave the first field blank and press Enter so that 
MFG/PRO assigns a value automatically.

• If you are modifying or deleting an existing record, type the key data 
for that record in the first field and press Enter. In most programs, 
you can also search for an existing record by pressing the up or down 
arrow keys in the first field.
 



USING MFG/PRO IN CHARACTER MODE 107
Common Commands
The most common commands are:

• F1 = Go (moves to the next folder)

• F2 = Help (opens field help, procedure help, and look-up browses)

• F4 = End (exits a folder or program)

• F5 = Delete (deletes a record you have selected)

• F7 = Page Up (scrolls up in browses)

For a complete list of commands, refer to:

• Table 6.2, “Accelerator Keys in Character Mode,” on page 107

• “Character Keyboard Commands” on page 5

Character Mode Keyboard Commands
MFG/PRO OBCM programs running in character mode behave similarly 
to the procedural programs, but some of the keyboard commands have 
changed. The following table shows some differences in keystrokes 
between the OBCM programs and other MFG/PRO programs.

Table 6.2
Accelerator Keys in 
Character Mode

Navigation Commands

Move to next folder F1

Move forward one field Tab or Enter

Move between key and data folders; accept (OBCM)  F12

Move forward and accept Enter (last field of group), F1

Move back one field Shift + Tab, Ctrl + U

End/Exit from folder F4

User choice of programs (standard) F6

Go to User Menu (OBCM) Esc – m

Go to previous record F9

Go to next record F10

Help

Field help F2

Procedure help F2
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User Interface Manager Functions
Ï See “Interface 

Management” on 
page 65 for 
details.

MFG/PRO includes several user interface management programs.

• Drill Down Maintenance (36.20.1)

• User Tool Maintenance (36.20.2)

• Menu Substitution Maintenance (36.20.3)

• User Profile Maintenance (36.20.4)

• Window Configuration and Security Maintenance (36.20.5)

• View Maintenance (36.20.13.12)

Remember to use the character mode function keys instead of Windows 
conventions.

Help browse -

Help look up windows F2 (if software is available)

Find field name Ctrl + F

Edit Command

Delete F5

Clear F8

Copy/paste F11, Ctrl + B

Navigation Commands
 



CHAPTER 7

Initialization Files

This chapter covers the elements of the PROGRESS initialization file 
having a direct bearing on MFG/PRO for Windows. This file is created 
during MFG/PRO installation. The file has an extension of .vga or 
.svg—progress.vga or progress.svg, for example—depending 
on the display resolution of the user’s computer.

The chapter covers the following:

CharWidth     110

Frame Spacing     110

Use_3D-Size     110

Probuild     110

Spin     111

Graph     111

Paint     111

Fonts     112
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CharWidth
You can change these font settings, but you must use only fonts with 
the same metrics.

CharWidth=8

DefaultFont=MS Sans Serif, size 8 bold

DefaultFixedFont=Courier New, bold, size=8

Frame Spacing
Leave this setting as it is.

;* New frame spacing parameter from PROGRESS - 
required for legacy code

FrameSpacing=1

Use_3D-Size
This setting determines the three-dimensionality of the field in MFG/PRO 
for Windows. Leave this setting as it is.

Use-3D-Size=no

Probuild
Leave these settings as they are.

PROBUILD=C:\DLC\PROBUILD

;PROPATH=.,C:\DLC\PROBUILD\EUCAPP,C:\DLC\PROBUILD\
EUCAPP\EUC.PL

propath=c:\mfgpro9,c:\mfgpro9\img\images.pl,r:\90\us
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Spin
This setting determines whether or not you can spin the globe on the 
MFG/PRO for Windows Sign-On screen. 

If you set it to Yes, you can spin the globe by clicking it. Double-click 
the globe to stop it from spinning.

spin=no

Graph
This setting allows graphing and points to the GRAFSMAN™ directory.

graph=yes

grafpath=c:\qad\grafsman

Paint
Ï For details on 

using this feature, 
refer to “Editing 
Images with the 
Edit Menu” on 
page 18.

This setting determines which imaging program you use when you edit 
graphics associated with the field. The default setting is Microsoft 
Paintbrush®. The images you create and edit are stored in the working 
directory.

paint=pbrush.exe

Note   Some versions of Windows and Windows NT include 
Microsoft® Paint rather than Paintbrush. If this is true of your computer, 
use a text editor to change this setting to paint=mspaint.exe.
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Fonts
You should leave the font section as it is.
[fonts]
;***********************************************************************
; THE DEFINITION OF FONT 0 THROUGH 7 IS PRIVATE TO THE PROGRESS ADE.  
; MODIFYING FONTS 0 THROUGH 7 MAY PREVENT THE PROGRESS ADE FROM RUNNING.
; The following fonts definitions correspond to the ADE standards.
;       ?  - Note choice of DefaultFont above (=FixedSys)
;       0  - Fixed System Font (1 char per PPU)  
;       1  - Proportional System Font
;       2  - Editor Font for 4GL program entry
;       3  - TTY Simulator (should be fixed)
;       4 - Desktop Font
;       5 to 7 - Reserved
font0=Fixedsys

.

.

.
font30=System

font31=System
 



Glossary

Accelerator Keys. Keystroke equivalents 
to mouse actions. For example, you can exit 
a program by clicking the exit button or by 
pressing Alt + X. During typing, or for people 
who remember keystrokes, accelerator keys 
can save time.

Browse. An inquiry program to display 
specific data, such as item or customer records. 
Browses are attached to many fields for use as 
drill downs. Browses also appear in the menus.

Button. An item on the screen that you click 
to initiate some action. For example, with the 
Windows interface, you click the  button 
to accept your input.

Calendar Button. A button attached to date 
fields and the object program tool bar, allowing 
you to view a calendar and select a date from it.

Character Programs. Refers to MFG/PRO 
programs running in Character User Interface, 
which displays only keyboard characters on the 
screen rather than icons and forms. Sometimes 
abbreviated as CUI or ChUI. 

Click. The action of pressing the left mouse 
button while pointing at an object with the 
mouse. You do this to indicate an object to 
the computer. For example, you point to an 
icon and click the mouse button to initiate an 
activity. See also Double-Click.

Click and Drag. See Dragging.

Combo Box. A program attached to a field to 
show you the valid entries for that field, such 
as codes.

Control Menu Box. In Windows, a box on 
the left of the title bar that you double-click 
to close the program.

Copy. A command that duplicates selected 
items into the Windows clipboard; you then 
paste the items.

Cursor. A graphic showing where your next 
keystroke will appear on the screen. You 
reposition the cursor by pointing and clicking 
with the mouse. See also Pointer.

Cut. A command that removes selected items 
by placing them in the Windows clipboard. 
You can paste the items from the clipboard, 
if you choose.

Device. Any piece of hardware available to 
the computer, such as a disk or a printer.

Double-Click. Clicking the mouse button 
twice in rapid succession. This normally results 
in a computer action. For example, you start 
MFG/PRO by double-clicking its icon.

Dragging. The action of pointing with the 
mouse, holding down the mouse button, and 
moving the pointer to another location. You do 
this to move (drag) an item on the screen, or 
to include an area in your selection, such as 
dragging over several fields to copy their 
contents.
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Drill Down. A browse program attached to 
a particular field, such as the Customer field. 
Drill downs display records in the database. 
You use such programs to find needed data. For 
example, the number of a customer whose 
name you remember.

Drop-Down Menus. Menus of common tasks, 
such as copying and cutting. Drop-down 
menus are available from the menu bar at the 
top of most Windows screens.

Field. A space on the screen to display or 
to accept data, or data values stored in the 
database.

File. A set of data, such as a master file, stored 
on disk. In PROGRESS terms, a file is also 
called a table.

Filter. A method for narrowing the data to be 
displayed in browses. For example, you may 
want to display item records in product line 
1500 only. A filter enables you to do this by 
entering selection criteria.

Frame. A group of fields, delimited by a box.

Function Key. A key located above the 
alphabetic keyboard to which functions can 
be assigned. For example, in MFG/PRO for 
Windows, F1 invokes field help.

Graphical User Interface (GUI). A method 
of presenting computer actions and options as 
pictures, buttons, and icons to users, rather than 
requiring typed commands. You interact with 
the computer by pointing and clicking with 
the mouse. The most common example of a 
Graphical User Interface is Microsoft 
Windows.

Grayed out. A formatting appearance applied 
to menu items and buttons when they are not 
available. For example, if nothing has been 
copied or cut to the clipboard, the Paste 
function is shown in gray.

Highlight. A display formatting appearance 
applied to selected items. For example, 
clicking on a menu topic causes it to display 
in reverse video.

Icon. A graphic representing a computer 
program or action. For example, the MFG/PRO 
for Windows globe is an icon.

Interface. The method of communication 
between humans and machines. For example, 
the steering wheel in a car is an interface 
between the driver and the car. MFG/PRO 
for Windows has a graphic interface. 
See Graphical User Interface (GUI).

Join. A relation between data in two or more 
tables expressed through fields that the tables 
have in common.

Key Data. The identifying field in a record: 
for example, the item number.

Keystroke Equivalents. Keystrokes that 
perform activities normally executed with the 
mouse. For example, pressing Alt + X is the 
same as clicking Exit on the User Menu.

Launch. To call up a program. For example, 
buttons on the tool bar launch programs.

Local Variable. A variable, created with 
PROGRESS syntax, to contain the relationship 
or derived value from one or more fields in one 
or more tables. For example, a local variable 
can contain a total derived from the quantity 
and the unit price.

Maximize. The process of enlarging a program 
window. You do this by clicking the maximize 
button in the upper right corner of most 
Windows screens.
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Menu. A list of options available to you at a 
given moment. MFG/PRO for Windows has 
program menus to take you through its suite 
of programs. The programs have drop-down 
menus for common activities, such as copying 
and accessing help.

Menu Bar. A space across the top of the 
program window containing the names of 
the various drop-down menus.

Menu Style. A type of menu. In MFG/PRO 
there are three menu styles: Icon, Tear Off, 
and Character.

Menu Substitution. Replacing one program 
with another on the menu. For example, you 
can set up the menu so that when users select 
a particular program, they get a customized 
version of it instead of the one delivered with 
MFG/PRO.

Message bar. An area at the bottom of 
MFG/PRO screens containing messages to 
guide you through your work.

Minimize. The process of decreasing the size 
of a program window. You do this by clicking 
the minimize button in the upper right corner 
of most Windows screens.

Mouse. A pointing device for indicating 
objects to the computer. For example, to run 
MFG/PRO, you use the mouse to point to the 
MFG/PRO icon, then double-click the mouse 
button.

Mouse Button. The button on the mouse you 
click to select items on the screen. Most mice 
have two buttons. Normally, you press the 
left button, but you can configure the mouse 
to accept input from the right button; this is 
especially useful for left-handed people.

Mouse Pad. A soft pad on which to move 
your mouse.

Mouse Pointer. A graphic on the screen 
showing what you are pointing at.

Navigation. Any method to move around 
the screen and through the programs. In 
MFG/PRO for Windows, you normally do 
this with mouse clicks. Within programs, 
such as Customer Maintenance, you also 
often use Tab.

Nesting. Setting a series of objects containing 
one another. For example, a drill down can 
drill down on another drill down, which can 
drill down on another, and so on.

No Access. A security level prohibiting access 
to data.

Object Programs. Programs that are written 
in the object-oriented style. This programming 
approach ties an object, such as an on-screen 
button that you press, to an action, such as 
exiting the program. Also called object-
oriented programs.

Paintbrush. An imaging program included 
with MS-Windows, available from the 
Accessories program group. This is the default 
program used for editing images attached to 
specific objects in your database.

Paste. Inserting a previously copied or cut 
item at a specified location.

Pointer. The icon that moves across the screen 
when you move the mouse across the mouse 
pad. It may appear as an arrow, hourglass, or 
text cursor. See also Mouse Pointer and 
Cursor.

Program Name. The technical program name, 
as opposed to the description that appears 
in the title bar. For example, Customer 
Maintenance is the description of a program 
called adcsmt.p.
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Program Window. The area on the screen 
used by a program. You can have more than 
one window open at a time. The window you 
are currently using is the active window.

PROGRESS Status Bar. An area at the bottom 
of the MFG/PRO screen containing 
information on available options. Also called, 
Status bar.

Read-Only Access. Access to data that is 
restricted to reading. Modifying read-only 
access data is prohibited. See Write Access 
and No Access.

Scrolling. Moving up and down and from 
side to side in a data representation (such as 
a report) that is too long or wide to fit on the 
screen. You use scroll bars or arrow keys to 
do this.

Selecting. Designating an item for action by 
the computer. For example, you select text and 
then direct the computer to delete it or make it 
boldface. You can select items with the mouse 
or the keyboard. 

Selection Criteria. Data used to include or 
exclude records and other data from the screen 
display. For example, you can direct the system 
to display only those items in product line 
1500.

Sorting. Arranging data in ascending or 
descending sequence. You can specify the 
field to be used for the sort, such as customer 
number or customer name.

Standard Programs. Programs that are 
written with a procedural and/or structured 
approach. These programs are called standard 
in MFG/PRO, because their numbers far 
exceed the number of object programs.

Store. To save changes made to data. If you 
do not do this, your changes are lost.

Table. A PROGRESS term for a file. See File.

Terminal. The computer screen.

Title Bar. The bar at the top of the screen 
showing a description of the current program. 
The description is not the same as the program 
name. For example, Customer Maintenance is 
the description of a program called 
adcn015.w.

Tool Bar. The area at the top of the screen 
containing buttons and icons for common 
activities such as accessing help and printing 
reports.

Undo. Reversing an action. For example, if 
you inadvertently delete something you want 
to keep, you can get it back if you undo the 
action immediately. This is available from the 
Edit menu or by pressing Ctrl + Z.

View. A logical entity showing data from two 
tables. It may show relationships between the 
tables in a local variable.

Wildcard. A symbol denoting multiple values. 
For example, cs* indicates all files starting 
with cs.

Window. The area on the screen taken up by a 
program. You can have more than one window 
open. The window you are currently using is 
the active window.

Write Access. Full access to data. Modifying 
the data is allowed.
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H
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PROGRESS

PROGRESS initialization file 109
PROGRESS Status Bar 13, 38

R
read access

setting 79
read-only access 78
reconfiguring

object programs in character mode 98
object programs in Windows 20

report programs 39, 44
 



INDEX 119
printing to a file 46
printing to the terminal 47
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customizable buttons on 31

U
User Interface Profile 71
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User Tool maintenance 69

V
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